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Abstract

Aluminum alloys containing 2 and 4 wt.% copper reinforced with aluminum
borides were successfully fabricated by squeeze casting employing squeezing
pressures up to 62 MPa. The distribution of reinforcements in the composites was
measured and the effect of pressure on density and hardness of the composites was
determined.  Additionally, the borides chemical stability was analyzed when the
squeezed composites were heat treated. The pressure effect on the squeezed
composites was investigated by optical microscopy, Vickers microhardness testing,
superficial Rockwell hardness testing, differential thermal analysis (DTA) and high
temperature X-ray diffraction (XRD). The superficial hardness of composites was
considerably improved by increasing the applied pressure during squeeze cast
process in comparison with specimens fabricated via gravity casting. The indirect
squeeze cast technique caused Al,Cu(0) phase segregation to upper regions of the
specimens. A slight formation of AIB, from the decomposition of the AIBi, was

promoted during the annealing of squeezed composites.
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Resumen

Aleaciones de aluminio con 2 y 4 %peso de cobre reforzadas con AlB1»
fueron fabricadas por la técnica indirecta de fundicién por alta presién; con
presiones desde 0.4 MPa hasta 62 MPa. En este proyecto se analizé la distribucién
de los refuerzos a lo largo del compuesto y se determiné el efecto de la presion
sobre la densidad y la dureza del material. Ademas, la estabilidad del refuerzo fue
determinada mientras el compuesto era tratado térmicamente. EIl efecto de la
presion sobre el compuesto fue caracterizado por diversos métodos tales como
microscopia Optica, microdureza Vickers, dureza superficial Rockwell, analisis
termal diferencial y técnicas avanzadas de difraccion de rayos X a alta temperatura.
El incremento de la presién aplicada durante el proceso de fabricacion, aumenté
ligeramente la dureza superficial del compuesto; ademas, promovié la segregacion
de la fase Al,Cu(6) a las regiones mas altas del espécimen, por otra parte, las
particulas de AlB+, permanecieron en las regiones bajas preferencialmente. La fase
de AIB+> mostré una lenta formacién de AIB, promovida durante el recocido de los

compuestos fabricados.
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1 INTRODUCTION

Aluminum matrix composites (AMCs) have found extensive use in many
engineering applications because of their high specific modulus, strength, hardness
and stiffness; excellent wear resistance, low-heat expansion coefficient, stability of
properties at elevated temperature, reduced density and competitive fabrication cost.
The development of these materials has been driven by the aerospace and
automotive industries for both nonstructural and structural applications. In recent
years the aerospace community has developed high-temperature aluminum alloys

capable of competing with titanium alloys.

The present thesis is focused on the fabrication via indirect squeeze casting
of aluminum-copper matrix composites reinforced with AlBy, particles. As a result,
the main goal was to study the effect of squeeze pressures on the density,
microhardness, hardness and thermal behavior of composites, as well as the
distribution of AlB+, particles upon casting and resulting shrinkage porosity. To
accomplish these goals this study includes the characterization of Al,Cu, AlB+, and

AlB; phases during annealing by in situ high temperature X-ray diffraction.
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1.1 Motivation

Casting is the most economical route to transfer raw materials into readily or
almost readily usable components. However, one of the major drawbacks for
conventional or even more advanced casting techniques, e.g., high pressure die-
casting is the formation of defects such as porosity. Furthermore, segregation
defects of hot tears, A and V segregates and banding could be potential crack
initiators during service operation of the as-cast components. New casting
techniques have, therefore, been developed to compensate for these shortcomings.
Of the many such casting techniques available, squeeze casting has greater
potential to create less defective cast components [1]. Squeeze casting is now the
most popular fabrication route for MMC artifacts. The annual 12-15% growth rate of
MMCs in the automotive, aerospace, sports and leisure goods and other markets is
a clear indication of better usage of advanced manufacturing routes such as

squeeze casting [2].

Generally, the engineering components fabricated by squeeze casting are
fine grained with excellent surface finish and have almost no porosity. They come in
a variety of shapes and sizes. The mechanical properties of these parts are
significantly improved over those of conventional castings and more sophisticated
casting routes of pressure or gravity die-casting. With this technique, properties
such as vyield strength, elongation and fatigue strength can be improved;

dimensional accuracy is similar to those of die-casting. It is further claimed that

3
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components fabricated by squeeze casting have superior weldability and heat
treatability. In addition, since squeeze casting may be carried out without any
feeding system, runners, gates, etc., and shrinkage compensating units, risers, the
yield is quite high with almost no scrap for recycling. Finally, in contrast to forging,
squeeze cast components are fabricated in a single action operation with lesser

energy requirements [1].

Aluminum—boron alloys have been used as additives to Al alloys to promote
grain refinement, precipitation hardening and mechanical reinforcement of Al-Base
alloys. In particular in the Al-B system, the AIB1, phase is a promising compound for
high temperature thermoelectric application and aircraft protection [3]. Al-B master
alloys are also used in the in situ fabrication of aluminum matrix composites. One
example is the in situ fabrication of AIB; fiber reinforced aluminum matrix composites

using an Al-B master alloy [4].

AMCs reinforced with dodeborides have not been studied despite being
strong and lightweight materials. AMCs combine the low density of the matrix with
the high hardness of the reinforcements. For this reason extensive analysis and
characterization of these AMCs are relevant if they are proposed as alternative

materials for aerospace applications.
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1.2 Literature Review

The squeeze casting process was first suggested by Chernov in 1878 [1] and
later it was introduced in the United States, Europe and Japan [5]. This process was
introduced in the United States in 1960 and has since gained widespread
acceptance within the nonferrous casting industry. Aluminum, magnesium and
copper alloy components are manufactured using this process. Several ferrous
components with relatively simple geometry have also been manufactured by

squeeze casting [6].

Zhang et al. [7] reported the effect of applied pressure during squeeze casting
process on microstructure and properties of the ZL205A alloy, which is a high-
strength casting aluminum alloy (named under Chinese designation). This has been
widely used for high-loaded structural parts. In this study, tensile strength and
elongation of the alloy were increased with increasing applied pressure; however,
the increase of tensile strength and elongation were apparent only at pressures less
than 45 MPa and 75 MPa, respectively. The squeezing pressure had significant
influence on the microstructure of the alloy; the grain size of the alloy decreased with
the increase of the squeezing pressure. With increasing pressure, the amount of
dimple on fractural surface increased, but the dimple size becomes smaller.
Microporosity could be seen easily in the alloy when the alloy was cast with no

applied pressure; as the squeezing pressure reached 25 MPa, the microporosity
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could be rarely found and it disappeared completely with increasing squeezing

pressure.

Maleki et al. [8] studied the effects of applied pressure, melt and die
temperatures on the density, macrostructure and hardness of squeeze cast LM13
alloy, which is a heat treatable cast Al-Si alloy with good bearing properties, good
fluidity and low coefficient of thermal expansion, commonly used for automotive
parts. This research showed that the density of the samples decreased with a 20
MPa external pressure but it increased steadily for higher applied pressures up to
about 106 MPa after which it became almost constant. Increasing the applied

pressure resulted in smaller grain size and improved hardness.

Maeng et al. [9] have investigated the direct squeeze casting of B390 as a
function of melt temperature and applied pressure. B390 alloy is a hypereutectic Al-
Si alloy characterized by its high wear resistance, which is typically used in ring
gears, engine blocks, pistons, etc. [10]. Mechanical properties such as hardness
and tensile strengths were greatly improved with increasing applied pressure. This
was due not only to the refinement of Chinese script microstructure but also to the
increase in solubility of solute atoms and a decrease of interdendritic pores with the

applied pressure.

Kajjari and Divandari [11] investigated the effect of pressure on the
microstructure and reduction of shrinkage porosities and the effect of squeeze

pressure (30, 50 and 70 MPa) on the microstructure and tensile properties of
6
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AA2024 aluminum alloy. The results showed that squeeze casting caused the
refinement of the microstructure and reduction in the dendrite arm spacing (DAS) of
the cast structure possibly due to higher cooling rates. Increasing the squeeze
pressure also led to formation of a finer microstructure. Furthermore, higher
pressures decreased the percentage of porosity and increased the density of the
cast alloy. The higher densities were found in the samples produced by squeeze
casting, although the density difference between the samples cast at 50 and 70 MPa
pressures is not appreciable. The ultimate tensile strengths of the squeezed cast

samples improved when the squeeze pressure increased.

Youn and Kang [12] investigated the nano/microstructure of squeezed cast
A356 alloy, the aging response (in T5 heat treatment), and the
mechanical/tribological properties of the eutectic regions. This squeeze cast alloy
(100 MPa) was used because no porosity was observed due to the well positioned
overflows. Porosity not only reduces mechanical properties, but also interferes with

heat treatment.

Some investigators have used composite materials fabricated via squeeze
casting in their researches. Arhami et al. [13] investigated the effect of vanadium on
the composition and morphology of intermetallics formed during the squeeze casting
(80 MPa) of Mg modified Al-8Fe—1.4V-8Si alloy in both monolithic form and as-

reinforced with SiC particles.
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Li et al. [14] fabricated an (AlsZr+Al>O3),/A356 particles reinforced aluminum
matrix composite; the composite melt was cast via permanent mold and squeeze
casting (65-80 MPa). One of the major drawbacks for the permanent mould casting
was the formation of defects such as porosity. In the squeeze cast composites the
defects were less pronounced and the grains were finer than those in permanent
mold composite. Additionally, the tensile strength, elongation, abradability and
corrosion resistance of squeeze cast composite were enhanced. The improved
properties of that composite were attributed to the high density and finer grain of the

matrix obtained via squeeze casting.

Chen et al. [15] fabricated aluminum matrix composites reinforced with
various levels and sizes of silicon carbide particles (SiCp) by squeeze casting (75
MPa). A lower melting point alloy (A383 Al) was squeezed into the higher melting
point (SiCy/pure Al) and (SiC,/6061 Al) preforms. The results showed that the SiC
particles were uniformly distributed within the matrices, and no pore was found in
these composites. The tensile strengths and elongations of the SiCy/pure Al/A383
Al and SiC,/6061 Al/A383 Al composites were both better than those of the A383 Al

alloy.

Jung et al. [16] developed a finite element model for the process of squeeze
casting (25 MPa) of metal matrix composites in cylindrical molds. The squeeze-
casting conditions directly influenced the MMC microstructure and the mechanical

properties, so that it was important to determine the optimal processing conditions.



Lilia Olaya-Luengas, Master Thesis, UPR-RUM. 2009

Trial and error procedure was used to develop new processes and optimize the
processing parameters. This approach is expensive and is also inflexible in that the
result cannot be adapted to other materials or shapes of mold. The model predicted

the cooling behavior from the processing parameters of the casting process.

Vijayaram et al. [5] reviewed the principles of squeeze casting technology,
which can be applied to process discontinuous fiber reinforced metal matrix
composite castings. In addition, they highlighted the type of engineering
components produced by this advanced casting method and concluded that the
squeeze casting can be adopted to produce superior quality composite castings.
The composite castings produced by this method were application-oriented
products, which can be manufactured by mass production. They noted that the
availability of the ceramic fiber performs in required size and shape favored and
helped the production of composite castings and that it has a strong potential. The
international and national market for squeeze cast components could not fully
exploited by the industries due to the lack of commercially viable machines. They
expected that this process fill up this gap and will become a harbinger for this

emerging technology.
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1.3 What is lacking?

The analysis of the literature review revealed that although there are some
researches which apply the squeeze casting, it is lacking an extensive research
about the AlB+2/Al composites and the squeeze casting as a fabrication technique of
composite materials. By this way the aluminum matrix composites could acquire the

good properties that this technique offers.

Some projects deal already with the AIB12/Al composites such as fabrication of
composite by different cast methods as centrifugal casting, rapid solidification and
squeeze casting. An exhaustive characterization of Aluminum matrix composite
reinforced with AlBi, particles, an analysis of the chemical stability of AIBi> as
reinforcement, determine the melting point of composites and analyze their possible
changes from as-casting composites and study the increase or decrease of each
one of the phases present in composite by X-ray diffraction during heat treatments

could be executed.

1.4 What is the relevance of the present work?

The relevance of the present project is the fabrication of AlB12/Al composites by
indirect squeeze casting method with several squeeze pressure, a moderate
improvement of mechanical behavior such as microhardness, hardness and bulk

density of squeezed AIB12/Al composite. A slight segregation of Al.Cu phase to

10
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upper regions of squeezed samples was observed and quantified by optical
microscopy and volume fraction respectively. Besides, the elastic modulus of the

composite material was calculated from volume fraction calculated.

The characterization of AIB1o/Al composites was accomplished by determining
the melting point of squeeze-composites with the help of differential thermal analysis
(DTA) and comparing with as-casting composites. Finally, a tracking of peaks of
Al,Cu and AIB, phases presented in squeeze-composites was carried out by high

temperature x-ray diffraction techniques.

1.5 Objectives

To fabricate and characterize aluminum-copper matrix composites reinforced

with AlB. particles by squeeze casting technique.

1.5.1 Specific Objectives

+ To design the squeeze casting prototype machine where the composite samples
will be fabricated and to determine the optimum parameters for its operation,
such as preheating temperature for mold, applied pressure and casting

temperature.

11



Lilia Olaya-Luengas, Master Thesis, UPR-RUM. 2009

To characterize the squeeze casting composites using optical microscopy and
scanning electron microcopy (SEM) with backscattered electron imaging

capabilities for determining the phases present and microstructure.

To calculate the volume fraction and distribution of reinforcement from optical
photographs of microstructures using ImagedJ image analysis software and to find

the elastic modulus of composite using that information.

To determine the phases present in the composites by means of X-ray diffraction
(XRD) and to determine the stability of these phases upon heat treatment using

high temperature XRD.

To measure the superficial hardness and to calculate the Meyer hardness of
composites in order to observe the changes of mechanical behavior when these

materials are fabricated via squeeze casting.

1.6 Outline of the thesis

Chapter 2 deals with the theory of squeeze casting process, and a critical

summary on the metal matrix composites, aluminum matrix composites and the

binary systems involved in the present research like Al-Cu and Al-B. Third chapter

presents the complete procedure, as well as design and manufacture of the mold-

piston system for squeeze casting process. The squeeze casting variables setting

and sample preparation for each characterization technique are also discussed.

12
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Fourth chapter presents the characterization process, the data analysis and the
discussion of those results. Finally, the chapter 5 includes the conclusions of the

present research.

[ Design and manufacture of squeeze apparatus ]

Fabrication of composites of
2 and 4 wt.% Cu by squeeze casting

[ Characterization of composites ]

Superficial Differential
Microstructural Vickers Rockwell Thermal X-Ray
Analysis Microhardness Hardness Analysis Diffraction
s N r
| [ Optical DSC XRD ]—
Microscopy )
High
. Temperature
Scanning . :
|| Electron L Diffraction
Microscopy
- J

Figure 1.1 Outline of research methodology

13
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2 THEORETICAL BACKGROUND

2.1 Squeeze Casting

Squeeze casting is a generic term to specify a fabrication technique where
solidification is promoted under high pressure within a re-usable die. Squeeze
casting consists of metering liquid metal into a preheated, lubricated die and forging
the metal while it solidifies. The load is applied shortly after the metal begins to
freeze and is maintained until the entire casting has solidified. Casting ejection and

handling are done in much the same way as in closed die forging [6].

Although squeeze casting is now the accepted term for this forming operation,
it has been variously referred to as “liquid metal forging” [6], “extrusion casting”,
“liquid pressing”, “pressure crystallization” and “squeeze forming”. Two basic forms
of the process may be distinguished, depending on whether the pressure is applied
directly onto the solidifying cast product via an upper or male die (punch) or the
applied pressure is exerted through an intermediate feeding system, as
schematically shown in Figure 2.1: the direct and indirect squeeze casting modes.
For the direct mode, two further forms may be distinguished, based on liquid metal

displacement initiated by the punch movement: (a) without metal movement, and (b)

with metal movement. As illustrated in Figure 2.2, the first form is suitable for ingot

14



Lilia Olaya-Luengas, Master Thesis, UPR-RUM. 2009

type components where there is no metal movement, while the second type
involving metal movement (also known as the backward process), is more versatile
and can be used to cast a wide range of shaped components [1]. In indirect
squeeze casting process, the metal is injected into the die cavity by a piston of small

diameter [7].

Press Ram
Punch
Punch Feeding System
Die Cast Product

Direct Indirect

Figure 2.1 Schematic diagram to illustrate the modes of the squeeze casting process
(a) direct and (b) indirect [1].

punch

Figure 2.2 Schematic diagram to show two forms of the direct squeeze casting process.
a) without metal movement. b) with metal movement [1].

15
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2.1.1 Process Outline

The process of squeeze casting involves the following steps [1]:

1. A pre-specified amount of molten metal is poured into a preheated, lubricated die
cavity, located on the bed of a hydraulic press, as shown in Figure 2.3 (a) and
(b).

2. The press is activated with pressures of up to 140 MPa [6] to close the die cavity
and to pressurize the liquid metal. This is carried out very quickly, rendering
solidification of the molten metal under pressure.

3. The pressure is held on the metal until complete solidification. This not only
increases the rate of heat flow, but also most importantly may eliminate
macro/micro shrinkage porosity. In addition, since nucleation of gas porosity is
pressure dependent, the porosity formation due to dissolve gases in the molten
metal is restricted, as indicated in Figure 2.3 (c).

4. Finally, Figure 2.3 (d) shows the casting ejection and handling done in much the

same way as in closed die forging.

The squeeze casting cycle starts with the transfer of a metered quantity of
molten metal into the bottom half of a preheated die set mounted in a hydraulic
press. The dies are then closed, and this fills the die cavity with molten metal and

applies pressures of up to 140 MPa on the solidifying casting.
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Punch

Induction
Furnace

Figure 2.3 Schematic illustrating squeeze casting process operations.
(a) Melt charge, preheat and lubricate tooling. (b) Transfer melt into die cavity. (c) Close tooling,
solidified melt under pressure. (d) Eject casting, clean dies, charge melt stock [6].

The high pressure applied (typically 55 to 100 MPa) is enough to suppress
gas porosity except in extreme cases, for which standard degassing treatments are
used. The tendency toward shrinkage porosity is limited by using minimal superheat
in the melt during pouring. This is possible in squeeze casting because of melt
fluidity, which requires high pouring temperatures, and is not necessary for fill the die,
the latter being readily achieved by the high pressure applied. In heavy sections of
the casting, which are particularly prone to the incidence of shrinkage porosity, the
applied pressure squirts liquid or semiliquid metal from hot spots into incipient

shrinkage pores to prevent pores from forming. Alloys with wide freezing ranges
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accommodate this form of melt movement very well, resulting in sound casting with

a minimum of applied pressure [6].

2.1.2 Process Variables

There are a number of variables that are generally controlled for the
soundness and quality of the castings. The variable ranges discussed in the
following sections vary with the alloy systems and part geometry being squeeze cast
[6]:

+ Melt volume: precision control of the metal volume is required when filling the
die cavity. This ensures dimensional control.

+ Casting temperatures depend of the alloy and the part geometry. The starting
point is normally 6 to 55°C above the liquidus temperature.

+ Tooling temperatures ranging from 190 to 315°C are normally used. The lower
range is more suitable for thick section casting. The punch temperature is kept
from 15 to 30°C below the lower die temperature to maintain sufficient clearance
between them for adequate venting. Excess punch-to-die clearance allows
molten metal to be extruded between them eroding the surface.

+ Time delay is the duration between the actual pouring of the metal and the
instant the punch contacts the molten pool and then starts the pressurization of
thin webs that are incorporated into the die cavity. Because increased pouring

temperatures may be required to fill adequately these sections upon pouring, a

18



Lilia Olaya-Luengas, Master Thesis, UPR-RUM. 2009

time delay will allow for cooling of the molten pool before closing of the dies in
order to avoid shrink porosity.

+ Pressure levels of 50 to 140 MPa are normally used; 70 MPa is generally
applied, depending on part geometry and the required mechanical properties.
There is an optimum pressure for each system after which no added advantages
in mechanical properties are obtained.

+ Pressure duration varying from 30 to 120 seconds has been found to be
satisfactory for casting weighing 9 Kg. However, the pressure duration is again
dependent on part geometry. Applied pressure after composite solidification and
temperature equalization will not enhance any property; it will only increase cycle
times.

¢ Lubrication for aluminum, magnesium and copper alloys has been proved
satisfactorily with a colloidal graphite spray lubricant applied on the warm dies
prior to casting. Care should be taken to avoid excess buildup on narrow webs
and fin areas where vent holes or slots are used. Care must also be taken to
prevent plugging of these vents. For ferrous castings, ceramic-type coatings are

required to prevent welding between the casting and the metal die surfaces.

2.1.3 Effect of applied pressure

Application of pressure on a molten metal during solidification may cause the

following effects [8]:
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Change in the melting point. Melting point (liquidus temperature) of most
metals and alloys increases under pressure, to satisfy the Clausius—Clapeyron
equation. This characteristic can be utilized to create sudden large undercooling
in the melt upon application of pressure if the melt temperature and timing of
pressure application are accurately controlled.

Change of solidification rate. In most casting processes an air gap is formed
shortly after pouring between the die and the solidified outer shell of the casting.
This is due to simultaneous contraction of the shell and expansion of the die. Air
gap formation changes heat transfer mechanism from conduction to convection
and radiation and causes a significant decrease in heat transfer rate and
consequently decreases the cooling rate. In squeeze casting, air gap formation
is eliminated as a result of the applied pressure on the casting and therefore heat
transfer and cooling rate increases considerably. Higher cooling rate, especially
if coupled with a prompt large undercooling as mentioned above, can cause
significant improvement in the structure and mechanical properties of the
castings.

Structural changes. Applied pressure causes structural changes by affecting
cooling rate of the melt and its undercooling. These structural changes include
decrease in dendrite arm spacing (DAS), more homogeneous distribution of
structural features and refinement and modification of intermetallic phases.
These factors cause improvement in the mechanical properties of squeeze cast

components.
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+ Reduction of gas and shrinkage porosities. It has been shown that gas
solubility in the melt increases under an applied pressure. This makes gas
bubble nucleation more difficult. It is also well established that application of an
external pressure during solidification of a casting activates the different feeding
mechanisms and hinders shrinkage porosity formation. Consequently, if a high
enough pressure is used, formation of both gas and shrinkage porosities may be

completely eliminated.

2.2 Metal Matrix Composites (MMCs)

One simple scheme for the classification of composite materials is shown in

Figure 2.4, which consists of three main divisions: particle-reinforced, fiber
reinforced, and structural composites; also, at least two subdivisions exist for each.
The dispersed phase for particle-reinforced composites is equiaxed; for fiber-
reinforced composites, the dispersed phase has the geometry of a fiber. Structural

composites are combinations of composites and homogeneous materials.

Composites
| : |
Particle- Fiber- Structural
reinf(I)rced reinfcl)rced .
| | 1 I 1 | | 1
Large- Dispersion- Continuous Discontinuous Laminates Sandwich
particle strengthened (aligned) (short) panels

Aligned Randomly
oriented

Figure 2.4 Classification scheme for the various composite types [17].
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The large-particle and dispersion-strengthened composites are the two
subclassifications of particle-reinforced composites. The distinction between these
is based upon reinforcement or strengthening mechanism. The term “large” is used
to indicate that particle-matrix interactions cannot be treated on the atomic or
molecular level; rather, a continuum mechanics configuration is used. For the most
of these composites, the dispersed phase is harder and stiffer than the matrix.
These reinforcing particles tend to restrain movement of the matrix phase in the
vicinity of each particle. In essence, the matrix transfers some of the applied stress
to the particles, which bear a fraction of load. The degree of reinforcement or
improvement of mechanical behavior depends on strong bonding at the matrix-
particle interface. For dispersion-strengthened composites, particles are normally

much smaller, with a size range between 0.01 and 0.1um.

In large-particle composite, particles can have quite a variety of geometry, but
they should be equiaxed. For effective reinforcement, the particles should be small
and evenly distributed throughout the matrix. Furthermore, the volume fraction of
the two phases influences the behavior; mechanical properties are enhanced with
increasing particle content. Two mathematical expressions have been formulated
for the dependence of the elastic modulus on the volume fraction of the constituent
phases for a two-phase composite. These rule of mixtures equations predict that the

elastic modulus should fall between an upper bound represented by

E.(u)=E,V,+EV, Equation 2.1
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and a lower bound, or limit,

— EmEp
E,V, +E,V,

E, (1)

Equation 2.2

In these expressions, E and V denote the elastic modulus and volume fraction,
whereas the subscriptions ¢, m and p represent composite, matrix and particulate

phases respectively [17].

Normally for the MMCs, the matrix is a ductile metal. These materials may be
utilized at higher service temperatures than their base metal counterparts; the
reinforcement may improve specific stiffness, specific strength, abrasion resistance,
creep resistance, thermal conductivity, and dimensional stability. Some of the
advantages of these materials over the polymer-matrix composites include higher
operating temperatures, non-flammability, and greater resistance to degradation by
organic fluids. Metal matrix composites are much more expensive than polymer

matrix composites, and therefore, their (MMCs) use is somewhat restricted.

Superalloys, as well as alloys of aluminum, magnesium, titanium and copper,
are employed as composite matrix. The reinforcement may be in the form of
particulates, both continuous and discontinuous fibers, and whiskers; concentrations
normally range between 10 and 60 vol%. Continuous fiber materials include carbon,
silicon carbide, boron, aluminum oxide, and the refractory metals. On the other

hand, discontinuous reinforcements consist primarily of silicon carbide whiskers,
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chopped fibers of aluminum oxide and carbon, and particulates of silicon carbide

and aluminum oxide. In a sense cermets fall within this MMCs scheme.

Some matrix-reinforcement combinations are highly reactive at elevated
temperatures. Consequently, composite degradation may be caused by high-
temperature processing or by subjecting the MMCs to elevated temperatures during
service. This problem is commonly resolved either by applying a protective surface

coating to the reinforcement or by modifying the matrix alloys composition.

Normally the processing of MMCs involves at least two steps: consolidation or
synthesis, followed by a shaping operation. A host of consolidation techniques are
available, some of which are relatively sophisticated; discontinuous fiber MMCs are
amenable to shaping by standard metal-forming operations (e.g., forging, extrusion,

rolling).

Automobile manufacturers have recently begun to use MMCs in their
products. For example, some engine components have been introduced consisting
of an aluminum-alloy matrix that is reinforced with aluminum oxide and carbon fibers;
this MMCs is light in weight and resists wear and thermal distortion. Metal matrix
composites are also employed in driveshafts (that have higher rotational speed and
reduced vibrational noise levels), extruded stabilizer bars, and forged suspension

and transmission components.
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The aerospace industry also uses MMCs. Structural applications include
advanced aluminum alloy metal-matrix composites; boron fibers are used as the
reinforcement for the Space Shuttle Orbiter, and continuous graphite fibers for the

Hubble Telescope [17].

Pressure infiltration of fiber preforms or powder beds are used in order to
produce void-free, near-net shape casting of composites. Aluminosilicate fiber
reinforced aluminum alloy pistons made by a Japanese automaker have been in use
in heavy diesel engines for some years, and a considerable amount of work has
been done on the pressure casting of ceramic particle and fiber-reinforced MMCs for

industrial applications [18].

2.3 Aluminum Matrix Composites (AMCs)

Aluminum (Al)-based metal matrix composites (MMCs) make up a distinct
category of advanced engineering materials that provide unique advantages over
conventional Al alloys. Aluminum matrix composites have been used in different
fields where low weight and thermal stability are key requirements. Typical
applications include aerospace components, electronic packaging, high precision
instrumentation, and automobile engine components [19]. At present, aluminum
alloy matrix composites (AMCs) are finding applications in automotive sector and
strategic sectors such as defense and aerospace, as well as in different segments of

other engineering industries [20]. The 6061 and 7015 aluminum alloys are used in
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the automotive industries (trucks, rail-road cars), towers and structural applications,
furniture, pipelines, canoes and other applications where strength, weldability and

corrosion resistance are needed [21].

Particle-reinforced AMCs represent an appealing alternative as an advanced
material due to their high specific heat capacity and thermal conductivity as well as
low density, high specific strength, high specific stiffness, controlled coefficient of
expansion, fatigue resistance and superior dimensional stability. AMCs with
excellent properties are tailor-made with different manufacturing methods like

powder metallurgy, liquid metal infiltration, squeeze casting, etc. [22]

Extensive theoretical and experimental studies have been carried out on the
fundamental relationships between the mechanical properties and the microstructure
of AMCs with different types of matrix and either particles or fibers as reinforcement.
The selection of the reinforcement type, geometry and volume fraction is critical to
obtain the best combination of properties at a low cost. The particles used for

reinforcement include: nitrides, borides, carbides and oxides [21].

2.3.1 AI-Cu System

An alloy system of ample commercial importance is aluminum-copper.
Although the phase diagram of this system is fairly complicated (see Figure 2.5), the
alloys of concern in this discussion are limited to the Al-rich region where a simple

aAl+AlCu (0) eutectic is formed. The AI-Cu based alloys (designated as 2xxx
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series) has nominal copper contents ranging from 2.3 to 6.3 wt.%, making them

hypoeutectic alloys.

A critical feature of this region of the diagram is the curvature of the solvus
line. At the eutectic temperature (548.2°C), 5.65 wt.% Cu will dissolve in aluminum.
At lower temperature, however, the amount of copper that can remain in the
aluminum solid solution under equilibrium conditions drastically decreases, reaching
less than 1% at room temperature. This is the typical shape of the solvus line for
precipitation hardening; if any of these alloys are homogenized at temperature in or
near the solid solution phase field, they can be strengthened by aging at a
substantially lower temperature [23].
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Figure 2.5 The aluminum-copper phase diagram, showing the composition range for the 2xxx series
of precipitation-hardenable aluminum alloys [23].
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2.3.2 AI-B System

Commercial Al-B alloys are produced via chemical reactions of KBF4 with
molten aluminum. Boron is reduced from the fluoride salt by aluminum and
disperses into the aluminum melt in the forms of aluminum borides, AIB, and AlB..
AlB1; is a high temperature phase, whereas AlB; is stable at room temperature when
the boron content is less than 44.5 wt.%, according to the Al-B phase diagram,
shown in Figure 2.6. According to the phase diagram Figure 2.6, a peritectic
reaction, L+AIB>—AIB,, takes place at 975°C. There is a discrepancy about the
peritectic temperature, which has been given in different numbers by different
investigators ranging from 956°C to 1350°C. During cooling AIB» reacts with liquid
aluminum to form AIB,. However, AIB, is always detected in AI-B master alloys
that have been produced via molten salt reactions at temperatures lower than the
peritectic reaction temperature for high boron concentrations. The presence of AlB1»
was also reported in Al-Ti—B master alloys that have been produced via arc melting
of aluminum and boron at 800°C. The presence of AlB1, at temperatures lower than
975°C continues causing confusion regarding the stabilities of the boride phases in

aluminum [4].
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Figure 2.6 Al-rich side of Al-B phase diagram [4].

Recent researches [24] had reported an Al-B phase diagram redrawn [25].
However, it was pointed out that the diagram was unlikely two segments of AIB1»
liquidus, which were separated by the existence of AlBo, could not be smoothly
continuous. Duschanek and Rogl reassessed this system and concluded that AlBqg
did not exist [25]. Mirkovi¢, D. et al. measured the AlB;; liquidus and determined the

form by thermodynamic assessment [3]. The result is shown in Figure 2.7.
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Figure 2.7 Al-B phase diagram redrawn [24].

According to Higashi, in the binary Al-B system only three phases, AIB,, ao-
AlB+, and (with less confidence) y-AlB1,, are considered to be binary aluminum
borides. The phases AlBy, and B-AIBi> may have been stabilized by carbon
impurity. The y-AlB42 could not be prepared as single crystals but as intergrown
crystals with a-AlB12 [26]. Although, Duschanek and Rogl [25] concluded that
a-AlB12 and AIB, are the only true binary aluminum boride compounds, Table 2.1

shows the crystal data for both phases.
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Table 2.1 Crystal data for the crystals of AIB, and a-AlB;»

Crystal AlB; [27] a-AlB12 [26]
Crystal system Hexagonal Tetragonal
a(A) 3.0054 10.158
b(A) (=a) (=a)
c(A) 3.25276 14.270
Chemical formula A|Bg ngAh,s
Pearson Symbol [25] hP3 P6/mmm
Space Group [25] tP216 P4,2:2
Density [28] 3.1 g/cm® 2.55 g/cm?®
Hardness [29] 26 GPa
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3 PROCESSING AND CHARACTERIZATION
METHODOLOGY FOR FABRICATION OF AIB,,/Al-Cu
ALLOYS COMPOSITES

This chapter presents the methodology used to fabricate Al-Cu alloys
reinforced with AIBy, particles via squeeze casting, and the corresponding
characterization methods. To produce these aluminum matrix composites an Al-5

wt.% B and Al-33 wt.% Cu commercial master alloys were used.

3.1 Squeeze Casting

Two sets of Al matrix composite specimens were fabricated via squeeze
casting with different squeeze pressures. The first set contained 2 wt.% Cu and
4.70 wt.% B and the second set, 4 wt.% Cu and 4.40 wt.% B. In both composites

boron was present forming AlB1, particles.

A Romanoff electric furnace with a graphite crucible was used to melt the
composites; the melted composite was kept at 750°C for 30 min. After melting, the
material was squeezed cast in an apparatus made of a stainless steel mold and a
piston system. These mold and piston were machined and assembled according to

Figure 3.1 and Figure 3.2 respectively.
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Figure 3.1 Machining of mold

Piston

@ 1.3cm

Release
mechanism

Figure 3.2 Cross section of system used for squeeze casting.

The stainless steel mold and hollow piston were coated with dry graphite
lubricant and pre-heated in a Barnstead Thermolyte muffle furnace at 660°C. The
molten composite matrix with solid AlB+, particles in suspension was poured into the
stainless steel mold. Before the matrix started solidifying near 660°C, pressure was
applied with the stainless steel hollow piston during the solidification process. The
applied pressures on the specimens ranged from 0.40 MPa to 62 MPa using a
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Carver hydraulic press furbished with a special fixture fabricated to enlarge the press

gap (Figure 3.3).

Figure 3.3 Press with special fixture.

3.2 Preparation of Samples

The mold containing the solidified specimen was air cooled. The fabricated
specimen was removed using the same press. Each cylindrical specimen obtained
from the squeeze casting process were 13 mm in diameter and 11 cm in length; the
specimens were cut to produce 5 cross sections along the squeeze casting
direction, as shown in Figure 3.4. This longitudinal mapping of the squeeze cast
piece allowed selecting the zones to be characterized. The cuttings of specimens
were done with an Allied High Tech high speed saw. All cut samples were analyzed
by optical microscopy, scanning electron microscopy, Vickers microhardness,

superficial Rockwell hardness, differential thermal analysis and x-ray diffraction.
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Figure 3.4 (a) Squeezed Specimen. (b) Sectioned Specimen

3.3 Characterization

3.3.1 Bulk Density

Specific gravity was measured using a Sartorius TE 212 scale furbished with
Sartorius YDK 01 density determination kit. Density is then calculated from specific
gravity following ASTM D 792-08 “Standard Test Methods for Density and Specific

Gravity (Relative Density) of Plastics by Displacement” [30].
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3.3.2 Microscopy Characterization

The whole metallographic procedure was carefully documented for
reproducibility purposes. All samples were mounted in epoxy resin. Grinding was
carried out with a series of 320, 400, 600, 800 and 1200 grit SiC paper using water
as the coolant/lubricant. Polishing was carried out using 3 ym monocrystalline
diamond suspension (Struers DP-Suspension M), and lubricant (Struers DP-
Lubricant Red HQ) on a short felt cloth (Struers MD-MOL) followed by final polishing
with a 0.05 um colloidal silica suspension (Struers OP-S) on short felt cloth (Struers
MD-CHEM). For the metallographic preparation Buehler Beta manual grinder and

polisher were used.

The microstructures of these two kinds of composites were observed using a
Nikon Epiphot 200 inverted optical microscope and Phillip scanning electron
microscope (SEM) with a detector of backscattered electron detector. Afterward, all

samples were tested using a Vickers microhardness unit.

3.3.3 Vickers Microhardness

The ASTM E 384-07 standard test method was used to determine the
microhardness of the composites [31]. A Buehler Micromet Il digital micro hardness
tester was used to perform the microhardness measurement on the composite

samples.
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3.3.4 Analysis of Volume Fraction

The volume fraction is used frequently in studies of metallurgical systems and
phenomena, and at the present project, this measurement was used to calculate the
elastic modulus of fabricated composites. Equation 3.1 states the equality of volume
fraction to the areal ratio, linear ratio, and point ratio of the selected phase [32]. It
has been shown by stereology and quantitative metallography that area fraction is

equal to volume fraction [23].
VV = AA = LI_ = PP Equation 3.1

Area fraction of Al,Cu and AIB1> was measured from images taken at 100X,

using Imaged image analysis software (See Appendix).

3.3.5 Superficial Rockwell Hardness

The ASTM E 18-07 standard test method was used to determine the Rockwell
hardness and the superficial Rockwell hardness of these materials [33]. The 15T
Rockwell superficial hardness test used a 1/16” (1.588 mm) ball indenter and a force
of 15 kgf. This method helped determine the overall effect of the microstructure (not

just the matrix) on the composite mechanical behavior.

Samples for superficial Rockwell hardness samples were ground on a 320 grit
SiC paper to eliminate cutting lines and to secure parallel opposite faces. The
samples were cleaned with powdered labware detergent.
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3.3.6 Differential Thermal Analysis (DTA)

Thermal analysis comprises a group of techniques in which a physical property
of a substance is measured as a function of temperature, while the substance is
subjected to a controlled temperature program. In DTA, the temperature difference
that develop between a sample and a inert reference material is recorded, when
both are subjected to identical heat treatments. The baseline of the DTA curve
should then exhibit discontinuities at the transition temperatures and the slope of the
curve at any point will depend on the microstructural constitution at that temperature.

A DTA curve can be used as a finger print for identification purposes [34].

A DTA curve can be affected by many factors as sample holder, sample mass,

heating rate or furnace atmosphere:

+ Sample holder: The geometry, size or heat-sink properties of a sample holder
can affect the heat transfer to the center of the sample.

¢+ Sample mass: The endothermic and exothermic reactions and thermal gradients
throughout the sample may have significant effects on DTA results.

+ Heating Rate: The heating rate plays the most important role in DTA. Since
thermal degradation is not only dependent on temperature but also on time,
thermal degradation of a sample at a higher heating rate will be less because of
the shorter time.

¢+ Furnace atmosphere: The effect of furnace atmosphere on the DTA curve
depends on the type of reaction, the nature of the decomposition product and the
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type of atmosphere used. Most DTA experiments are conducted under an inert
atmosphere, usually nitrogen. Nitrogen increases sensitivity because it is a
relatively poor thermal conductor. Other inert gas, such as helium can be used.
This has a higher thermal conductivity than nitrogen, and helium can reduce its

thermal resistance and increase the resolution of thermal transitions.

A Mettler Toledo TGA/SDTA 851° was used to measure the thermal evolution
of the composites upon heating and cooling under a nitrogen atmosphere. A seven
milligrams sample in alumina crucible of 30uL was used for this analysis in a
nitrogen atmosphere with 20 mL/min of flow. The heating cycles were carried out at
10°C/min from 25°C to 750°C, followed by a cooling cycle from 750°C to 25°C at

-10°C/min.

3.3.7 X-Ray Diffraction (XRD)

The bulk XRD samples were prepared as solid pieces using a Buehler Isomet
low speed saw, and then ground manually with a 1200 grit SiC paper and water as
the coolant/lubricant, washed with powdered labware detergent and cleaned with
ethanol solution. The diffractometer was operated at 40 kV and 44 mA with a

metallic target of Cu Ku radiation, which emit strong x-ray of 1.54 A.
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3.3.8 XRD + Differential Scanning Calorimeter (DSC)

The XRD DSC samples had the same pan size, 5x5 mm and 0.2 mm of

thickness; in test performance the pan was removed.

The Rigaku Ultima Il XRD with Thermo plus XRD DSC II attachment was
used to anneal the samples and analyze the peak intensity changes while the
diffractograms were recorded in situ under nitrogen atmosphere (Figure 3.5). The
annealing was set to 300°C for 2 hours with heating rate 20°C/min (max) and the

diffractometer parameters were set from 20=5°to 40° with 9 deg/min of scan speed.

Figure 3.5 XRD DSC chamber with a composite sample.

3.3.9 High Temperature XRD

The samples for the high temperature XRD were machined to match the
black quartz sample plate size: 13x5 mm and 0.2 mm of thickness. The composites
melting process was studied using the Rigaku Ultima Ill XRD with programmable
temperature controller PTC-30 (Figure 3.6). The temperature controller was set with

a heating rate at 50°C/min (max) to reach 800°C holding the temperature for 2 hours.
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The diffraction test parameters were 26 between 10°- 100° and 9 deg/min of scan
speed. The tests were completed under a nitrogen atmosphere. Although the XRD
patterns were registered before, during and after heat treatment, in this section just
patterns recorded before and after the melting tests will be shown, because the

melted aluminum signal was noisy and it hid room temperature patterns.

Figure 3.6 Rigaku XRD executing a high temperature test.
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4 ANALYSIS AND DISCUSSION OF
CHARACTERIZATION OF AIB,,/Al-Cu ALLOYS
COMPOSITES

4.1 Bulk Density

The composites density was calculated from the specific gravity determined
using the Archimedean principle. Equation 4.1 shows the specific gravity calculation
[35].

_ W(a)-p(f)
W (a) - W(fl)

P Equation 4.1

where:

P : Specific gravity of the solid
P (fl): Density of the liquid

W (a): Weight of the solid in air

W(fl): Weight of the solid in liquid

The effect of the applied pressure on the sample density is presented in
Figure 4.1. The lower points in the plot indicate that the applied pressure was not

enough to counteract the inherent porosity of these Al-B-based composites.
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When these results are compared with the density of specimens fabricated
using gravity casting, it becomes apparent that bulk density of the squeeze cast
specimen increased in both composite compositions. In the 2 wt.% Cu specimen,
the density had a slight increase from 2.7178 to 2.7183 g/cm® and in the 4 wt.% Cu
specimen the density increased from 2.7549 to 2.7643 g/cm?®. Although the density
is expected to increase continuously with the applied pressure, Figure 4.1 shows a

drop in the density at 31 MPa of applied pressure.
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Figure 4.1 Bulk Density of composite fabricated
As known, when the composites are fabricated via gravity casting, shrinkage
forms on the top surface and is not accounted for as a part of the internal porosity of
the specimens. With low applied squeeze pressure (0.4 and 31 MPa) during the

solidification, shrinkage was not counteracted, and formed towards the medium-
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section of the specimens. As a result of the applied pressure (not large enough to

eliminate the shrinkage), smaller density values were obtained.

Higher applied pressures (46 and 62 MPa) slightly increased the squeezed
castings density. With this increment in the applied pressure the shrinkage porosity
was practically eliminated and the density approached its theoretical value.
According to the results of bulk density measured, it was reasonable to assume that
at the pressures of more than 50 MPa they were able to eliminate shrinkage porosity

in both composites (2 and 4 wt% Cu).

4.2 Microstructural Characterization

Figure 4.2 (a) presents the resulting microstructures with AIB12 reinforcements
embedded in the aluminum matrix and AlLCu (0) phase in the matrix grain
boundaries. Additionally, small and fewer particles of AlB, were identified in some

samples (Figure 4.2 (b)).

Figure 4.2 Observed phases in composites.
(a) 4 wt.% Cu sample fabricated with 62 MPa of squeeze pressure, cut at 10 cm of specimen bottom.
(b) 2%Cu sample fabricated with 62 MPa at bottom specimen.

44



Lilia Olaya-Luengas, Master Thesis, UPR-RUM. 2009

Optical microscopy also allowed observing the segregation of the Al,Cu (6)
phase onto the upper sections in the squeezed specimens. Figure 4.3 shows the

distribution of AloCu (8) phase from bottom to top section the same specimen.

! E e T b I | c‘é; O‘ 0 M[ﬁ_ﬁ] \
Bottom Top

| ———

300 um

Figure 4.3 Optical micrographs from the bottom and top sections
of the squeezed cast 4 wt.% Cu specimen fabricated with 62 MPa.

As a consequence of the applied pressure, some intergranular cracks were
formed at mid-length of some samples, as shown in Figure 4.4. However, the crack
propagation was stopped by the AlB+, reinforcements (Figure 4.4 (c)). It is believed
that the solidification shrinkage could not be counteracted by lower applied squeeze
pressures (0.4 and 31 MPa). Conversely, the shrinkage was reduced when higher

squeeze pressures (46 and 62 MPa) were applied.
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Figure 4.4 Micrographs of cracks observed.
(a) 2 wt.% Cu specimen squeezed with 31 MPa, obtained at 2.5 cm from the casting bottom.
(b) 4 wt.% Cu specimen squeezed with 31 MPa, obtained at 10 cm from the casting bottom.
(c) 2 wt.% Cu specimen squeezed with 0.4 MPa, obtained at 5.0 cm from the casting bottom.

The backscattered electron imaging (BEI) allowed detecting atomic number
contrast between areas with different chemical compositions, especially when the
average atomic number of the various regions is different. The phases observed
initially by optical microscopy were confirmed using BEI. The effective atomic

numbers (Ze) [36] were 6.65 and 21.17 for AlB2 and Al,Cu respectively (Figure 4.5

(a))-
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BEI was used along with energy dispersive x-ray spectroscopy (EDS) to

confirm the presence of boron and aluminum in the AIB12 reinforcement, as shown

Figure 4.5 (b) and (c).

Counts

B

0.20 0.40 0.60 0.80 100 1.20 1.40 160 1.80 2.00 2.20 240 260

keV

Figure 4.5 EDS analysis from BEI image to an AIB;, particle.

4.3 Analysis of Volume Fraction of Al,Cu and AIB:, Phases

area fraction according to Equation 3.1.

Microstructural features were quantified by calculation of volume fraction from

Area fraction of Al,Cu and AlBi> was
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measured from images taken at 100X, using Imaged image analysis software. The
overall volume fraction results of AlB1> and Al.Cu are presented in Figure 4.6 where
each plotted bar represents the volume fraction average (Al.Cu and AIB> phases)
corresponding to each cross section of specimen fabricated with specific

composition and pressure.
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Figure 4.6 Calculated volume fraction of Al,Cu and AIB,, phases.

According to these results, the squeeze casting process caused Al.Cu phase
to form preferentially in the upper regions of specimens. When compared with
gravity casting samples, the squeezed specimens showed higher amounts of this
phase along (1.5 times higher in 2 wt.% Cu samples). This ratio was barely
noticeable (0.2%) in the 4 wt.% Cu samples. With respect to reinforcements of AlB1»,
these particles remained preferentially at the end (bottom and top) regions of the
specimens, the AlB+, phase decreasing from bottom to the fourth cutting (at 7.5 cm)
of specimens, that was calculated in 13.6% and 40.8% for 2 and 4 wt.% Cu

specimens respectively. Additionally, the amount of AlB+, increased in the last part
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at 10 cm; this increment was 39.5% and 48.3% for the 2 and 4 wt.% Cu samples,

respectively.

This behavior of AlB+, reinforcement was probably caused by a slower cooling
rate at half long region of the specimens. On the other hand, the upper region was
the first to solidify and its particles could be retained in the matrix at the levels

indicated in Figure 4.6.

With the volume fraction calculation of AlB+, reinforcement, it was possible to
determine that the volume fraction average of reinforcement in the fabricated

composites was 15% + 4. In addition, the reinforcement size was measured by

mean ImagedJ image analysis software between 10-100 um.

4.4 Vickers Microhardness

The Vickers hardness value is calculated as follows:

_1854.4P

HY ==

Equation 4.2

where:
d: mean diagonal length of the indentation, um

P: force, gof
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A 25 ¢f load was applied for 30 seconds to perform the test on the aluminum
matrix (free of borides and 6 phase) of the composites, resulting in a average 35.5

HV value for the 2 wt.% Cu samples and 42.3 HV for 4 wt.% Cu ones.

In both composites the highest applied squeeze pressure (62 MPa) appeared
to barely increase the matrix hardness, as observed on the Figure 4.7 The mean
Vickers microhardness of squeezed specimens was 38.5 HV for the 2 wt.% Cu
specimen and 48.7 HV for the 4 wt.% Cu specimen. In general, Vickers
microhardness of squeezed specimens was slightly lower than the measurements of
the same composites fabricated via gravity casting. For the highest squeezed
pressures (46 and 62 MPa) the average microhardness was equal to that measured

on the gravity casting specimens.
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Figure 4.7 Vickers microhardness (HV 25gf/30s) values measured on the matrices
of the AMCs fabricated with different squeeze pressures and both 2 and 4 wt.% Cu.

The specimens fabricated with 62 MPa of squeeze pressure had a matrix with

the highest microhardness than the other samples. This behavior was due to the
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applied squeeze pressure during the matrix solidification likely introduced higher

dislocation densities that result in a stronger matrix.

4.5 15T Superficial Rockwell Hardness

Figure 4.8 shows superficial Rockwell hardness of composites fabricated via
squeeze casting and gravity casting as a function of the distance along the
specimens. In this figure the 4 wt.% Cu squeezed specimens showed higher
superficial hardness than the 2 wt.% Cu squeezed specimens with 63 HR15T. This
evidences the hardening effect of higher contents of copper. The higher pressure
caused the reinforcements to redistribute throughout the specimen. Seemingly,
these differences in distribution caused a non homogeneous composite material with

superficial hardness variations.
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Figure 4.8 Superficial Rockwell hardness (15T) values
measured on AMCs fabricated with different squeeze pressures and both 2 and 4 wt.% Cu.

Evidently the superficial Rockwell hardness was improved with the

implementation of squeeze casting as a fabrication method. In the 2 wt.% Cu
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specimens, the superficial hardness increased 14.4% and in the second set of 4
wt.% Cu specimens the increment was 14%, in both cases with respect to superficial
hardness of gravity casting samples. This behavior showed that the superficial
hardness was greatly affected by applied squeeze pressure. This is due likely to the
enhancement of solubility of solute atom as Cu and B and the decreasing of

shrinkage porosity by applied pressures.

4.6 Differential Thermal Analysis (DTA)

The DTA curves exhibited two endothermic peaks during the heating cycle.
The first peak (at lower temperature) corresponded to a eutectic reaction (solidus
line) and the second one to the matrix melting point (liquidus line) of the matrix.

These temperatures do not correlate exactly with the phase diagram of Figure 4.9.
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Figure 4.9 Phase diagram Al-Cu.
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This behavior can be explained as follow: the total amounts of aluminum in
the composites were 91.6 and 93.3 wt.% for 2 and 4 wt.% copper specimens
respectively. However, a small amount of aluminum is present in the AlBy2
reinforcement. Then, the aluminum and copper levels in matrix were increased and
the locations of both Al-Cu alloys in phase diagram were displaced to the right, from

4 wt.% Cu to 4.22 and from 2 wt.% Cu to 2.10.

The thermal event due to the first reaction was only observed in the 4 wt.%
specimens at 542 + 1.2°C (Figure 4.10). This temperature was stable in all samples
and represents the eutectic reaction (solidus line): a-Al+8—Liquid.
Additionally, this reaction was confirmed by mean of microstructure of these samples
taken at 1000X, the eutectic phase was identified at grain boundaries (Figure 4.11).
The recorded temperature was slightly lower than solidus line of the Al-Cu phase
diagram, subsequently this behavior confirm for a second time that the Al-Cu phase
diagram of this matrix was shifted to the left (Figure 4.9). Table 4.1 shows the
differences between the obtained temperatures in the DTA (heating and cooling) and

from the literature.
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Figure 4.10 Phase change of all analyzed 4% Cu samples.

Figure 4.11 Eutectic phase observed in 4 wt% Cu samples.

Table 4.1 Comparative chart of phase change signal (by heating and cooling) and solidus line of

reference.
Phase Change Phase Change Eutectic
: (solidus line) (solidus line) Temperature
Specimens for Heating for Cooling | (solidus line) (°C)
by DTA Onset (°C) | by DTA Onset (°C) [37]
4.22 wt.°/9 Cuin 542 541 548
matrix
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The Al,Cu (0) phase formed preferentially on the top regions of the
specimens, consequently, the melting points of the top samples were shifted to the
left in the DTA curves (lower temperature). Figure 4.12 shows the tendency
described previously for a specimen fabricated by 46 MPa of squeeze pressure.
The first derivative plots were used to detect and confirm the thermal events like

melting points or other phase changes.
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Figure 4.12 DTA and 1* Derivative curves of 4 wt.% specimen
fabricated with 46 MPa of squeeze pressure.

The highest squeeze pressures (31 - 62 MPa) increased the melting point in
all bottom regions of the specimens, as the DTA curves show in Figure 4.13.
According to the Al-Cu phase diagram, that behavior indicates Al-richer matrix in the
bottom regions of both specimens. The melting reactions by DTA onset were
identified and averaged to 648°C for the 2 wt.% Cu specimens and 639°C for the 4
wt.% Cu specimens. These temperatures were slightly lower than expected

according to the Al-Cu phase diagram (Table 4.2).
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The average melting point of the matrix of the squeezed specimens was
evidently higher than the melting points of the specimens fabricated via gravity
casting. This increment was calculated as 0.5 and 1.4% for 2 and 4% Cu
specimens, respectively. In addition, in Figure 4.13 there is a perceptible slope
between bottom and the rest of squeezed specimens. This slope was calculated
and averaged for specimens fabricated only with highest squeeze pressures (31, 46
and 62 MPa) to —3.5°C/cm. This is equivalent to a melting point difference of 6.2
and 6.4°C for the 2 and 4 wt.% Cu samples respectively from the bottom to the rest

of specimens.

Table 4.2 Comparative chart of melting point, solidification and liquidus line of reference.

Melting Point Solidification Melting Point
Specimens (Heating) by (Cooling) by (liquidus line) (°C)
DTA Onset (°C) | DTA Onset (°C) [37]
2.10 wt.% Cu in matrix 648 654 655
4.22 wt.% Cu in matrix 639 649 650

660
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&—2%GCu 0.4 MPa O0-4%Cu 0.4 MPa
—0—2%Cu 31 MPa 0-4%Cu 31 MPa
——2%GCu 46 MPa ——-4%GCu 46 MPa
620 ——2%Cu 62 MPa ——-4%Cu 62 MPa
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Figure 4.13 Melting points of all analyzed samples.
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4.7 X-Ray Diffraction (XRD)

4.7.1 XRD + Differential Scanning Calorimeter (DSC)

The first aluminum diffraction angle [38] is 20=38.474° for the plane (111).
The same peak was compared for the 5 distances along each specimen. According
Figure 4.14, this aluminum peak shifted to the left during heat treatment. This
behavior corroborated the thermal expansion of the aluminum unit cell. When the
samples were cooled to room temperature after annealing, the aluminum peak

returned to its original position.

Intensity (Counts)

i 385 39 395 40
Time (min 365 37 375 38 . .
(min) Two-Theta (deg)

Figure 4.14 XRD Patterns of Al 26=38.4°(111) at5 cm from specimen bottom
2 wt.% Cu sample fabricated by squeeze casting with 31 MPa of applied pressure.

The composite matrix (made of aluminum and copper) contained also Al>Cu,
observed by optical microscopy and detected by XRD. The Al,Cu diffraction peaks
within 20=5 - 40° range [39] were 20.620° (110), 29.386° (200) and 37.867°
(211). Figure 4.15 shows the first and second Al,Cu peaks detected and their

increasing could be observed. The third Al,Cu peak at 26=37.867 ° was not possible
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to observe because this peak was overlapped with the aluminum peak at 6=38.474°
(111). The amount of Al,Cu increased during the annealing heat treatment due to
further stabilization of the microstructure regardless of the presence of borides. This

was corroborated during the XRD DSC experiments.
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Figure 4.15 Al,Cu peak increasing.
(a) Al,Cu peak increasing 26=20.6°at 10 cm from specimen bottom. 2 wt.% Cu sample and 31 MPa
of squeeze pressure.
(b) Al,Cu peak increasing 26=29.4° at 5 cm from specimen bottom. 4 wt.% Cu sample and 0.4 MPa
of squeeze pressure.

The fabricated composites were reinforced with AlB4. clusters; according to
literature [40] there are 3 reported AIBi» peaks from 20=5° to 40° with intensity
higher than 25%: 22.607° (202), 36.496° (242) and 36.947°(341) all detected
by this experiment. Figure 4.16 (a) shows the first AlBy, peak detected at
20=22.607°, this peak height decreased during heat treatment. The second and
third AlB+, peak at 26=36.497 and 36.947 were also detected. As these peaks are
close together then they were exhibit like one wide peak. This peak is shown in
Figure 4.16 (b). A slight left shift during heat treatment was detected, which can be

interpreted like a cell size increasing, when the heating was released the peak and
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cell came back to 26 position and size original, respectively. Also, during the heat

treatment, the intensity of this wide peak slightly decreased.
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Figure 4.16 AIB,, peak increasing.
(a) AIB4, peak increasing 20=22.6° at specimen bottom. 4 wt.% Cu sample and 31 MPa of squeeze
pressure.
(b) AIB+, peaks increasing 26=36.5°and 36.9°at 10 cm from specimen bottom. 4 wt.% Cu sample
and 0.4 MPa of squeeze pressure.

In the fabricated composites some AlB; particles were previously identify by
optical microscopy and SEM. This phase was studied in the diffractograms recorded
at 300°C in the XRD DSC. According to the literature [27], AIB, peaks within
20=5 - 40° range were reported at 26=27.418° (001) and 34.414° (100). The
AlB; peak at 6=27.418° experimented a noticeable intensity increase upon annealing
in all samples. Before annealing none of the samples showed the 27.418° AlB;
peak. This peak appeared and increased in 11.5% of mean during annealing.
Figure 4.17 (a) shows the AIB, peak behavior described. The AIB, peak at
20=34.414°, increased slightly in both 2 and 4 wt.% Cu specimens during heat

treatment, as shown in Figure 4.17 (b). The increasing of AlB, peaks could be
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interpreted as a quantity increasing of AlB, phase in both 2 and 4 wt% Cu

specimens during annealing.
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Figure 4.17 AIB, peak increasing.
(a) AlB, peak increasing 206=27.4° at 2.5 cm from specimen bottom. 2 wt.% Cu sample and 31 MPa
of squeeze pressure.
(b) AlB, peak increasing 26=34.4° at 5 cm from specimen bottom. 4 wt.% Cu sample and 0.4 MPa of
squeeze pressure.

The formation of AIB, by decomposition of AlB, is proved by the slight
reduction of AlBi> peak height at 26=36.496 and 36.947° and the appearance and

heightening of AlB, peaks during heat treatment.

4.7.2 High Temperature XRD

According to the literature [38, 41], there are 6 aluminum peaks for the 26
range studied 38.474° (111), 44.723° (200), 65.100° (220), 78.234° (311),
82.441° (222) and 99.190° (400). All these peaks were identified in the XRD
patterns. Figure 4.18 shows a XRD pattern from 26=10° to 100° of a squeezed

sample before and after heat treatment. After melting the samples at 800°C in XRD,
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the intensity of aluminum peaks decreased except for the peak at 20=82.4 that

increased.
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Figure 4.18 XRD patterns of cross section at 5 cm from bottom specimen
fabricated with 4 wt.% Cu and 31 MPa of squeeze pressure.

An additional test was conducted in gravity casting specimens; the
temperature controller was set to a slow heating rate. The aluminum peaks shifted
to the left as in the XRD DSC experiment, and then these peaks vanished when the
temperature reached the matrix melting point. Yet, these peaks reappeared when

the sample was cooled (Figure 4.19).
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Figure 4.19 Al Peak at 26=65.1°0f (200).
Heating slowly to 900°C in reactor X attachment. Gravity casting sample with 4 wt.% Cu.

The Al,Cu phase was also detected in XRD pattern: at 26=20.620 (110),
29.386 (200), 42.591 (112), 47.332 (310), 47.808 (202)and 97.062 (314)
[39]. The first Al.Cu peak had an important increment, but the other peaks tended to

keep the same intensity (Figure 4.20).
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Figure 4.20 XRD patterns of cross section at 10 cm from bottom specimen
fabricated with 4 wt.% Cu and 31 MPa of squeeze pressure.

Upon melting, it was very important to study the reinforcement behavior in the
composites. The AlB1, was detected in the XRD patterns, at [40] 20= 22.607 (202)
and 36.947 (34 1). The first AlBy2 peak was not easy to identify, because this peak
overlaps with the Al,Cu peak. However, a slight increment of the AIB1, peak was
also determined. The AIB1, peak increased in both specimens while the second

peak decreased (Figure 4.21).
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Figure 4.21 AIB;, peak increasing.

(a) AIBy, peak increasing 26=22.607 at specimen bottom. Smelted sample at 800°C hold 2 hours. 4
wt.% Cu and 0.4 MPa of squeeze pressure.

(b) AlB42 peak decreasing 26=36.947° at 2.5 cm from specimen bottom. Smelted sample at 800°C
hold 2 hours. 4 wt.% Cu and 31 MPa of squeeze pressure.

AIB, detection by optical microscopy and SEM motivated to track the AlB;

peaks using XRD. According to the literature [27], there are 4 peaks with their

intensity higher than 25%: 26=34.414 (100), 44.542 (101), 56.539 (002) and

61.694 (110). The first AIB, peak decreased slightly, while the remaining peaks

showed that their intensity increased as shown in Figure 4.22.
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Figure 4.22 AIB, peak increasing.
(a) AIB; peak increasing 20=34.4° at 2.5 cm from specimen bottom. Smelted sample at 800°C hold 2
hours. 2 wt.% Cu and 0.4 MPa of squeeze pressure.
(b) AIB, peak increasing 26=56.5° at the specimen bottom. Smelted sample at 800°C hold 2 hours. 4
wt.% Cu and 0.4 MPa of squeeze pressure.
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5 CONCLUSIONS

As a result of the squeeze casting process, the manufactures composites had
better mechanical, micro and macrostructural characteristics compared with the
conventionally processed ones via gravity casting. The key to this task was the
control of the processing variables. The most important squeeze casting process
parameter that affected the quality of castings was the intensity of applied pressure.
Effects of this parameter on the density, microhardness, superficial hardness,
differential thermal analysis and x-ray diffraction of AIB1o/Al composites were

investigated in this work.

The bulk density of the squeezes specimens presented a slight increase due to
the applied pressure. The bulk densities measured were 2.7178 and 2.7549 g/cm?®
for both 2 and 4 wt.% Cu specimens respectively fabricated via gravity casting.
Finally, the bulk density increased to 2.7183 and 2.7643 g/cm in the same
composites fabricated via squeeze casting with 62 MPa of applied pressure. This
slight increasing in bulk density was caused by the elimination of the shrinkage

porosity during processing.

In both composites the highest applied squeeze pressure (62 MPa) slightly

increased the matrix hardness. This increment likely corresponds to a higher
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dislocation density in the matrix due to the highest pressure (62 MPa) applied during

the solidification of the matrix. This also helped to eliminate shrinkage porosity.

The superficial Rockwell hardness was improved with the implementation of
squeeze casting as a fabrication method. In the first set of 2 wt.% Cu specimens,
the superficial hardness increased 14.4% and in the second set of 4 wt.% Cu
specimens the increment was 14%. This noticeable increment was caused by the
pressure applied during the matrix solidification of composites; the matrix was forced
to fill the piston and to compact itself eliminating the shrinkage porosity producing

harder composites.

Differential thermal analysis permitted evaluating the melting process of both
sets of specimens fabricated via squeeze casting. The mean melting points were
648°C and 639 °C for 2 and 4 wt.% Cu specimens respectively. The increment of the
melting point of both specimens fabricated via squeeze casting was caused by the
increase in applied pressure. The eutectic transformation detected at 544 °C for the
4 wt.% Cu specimen occurred as consequence of the presence of boron which
reduces the solubility of Cu in the Al matrix. The pressure effect and boron caused
that the eutectic line extended to the left (Al-rich side). The 2 wt.% Cu specimens
did not show any eutectic transformation, then the extension of the eutectic line did

not reach this composition.
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By means of XRD DSC a mean increment of 32.5% in the AlLCu (0) peak
intensity was observed during the annealing of samples due to further stabilization of
the microstructure regardless of the presence of boron. The formation of AlB, from
AlB+2 has been proved by the slight decrease of intensity of the wide peaks of AlB+»
at 20=36.496 and 36.947°, and the appearance and increase of AIB, peaks intensity
during the annealing process. Similar results were obtained from the high
temperature XRD, where the AIB1> phase was slightly reduced and the AIB, phase
was increased. By this way, it was confirmed the presence of both types of

reinforcements in the composites fabricated via squeeze casting.
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Appendix

1. Why ImagedJ ??

ImagedJ is a free software and has more than
300 plug-in
Some applications for metallography:
. Volume Fraction
Reinforcements and Pores
. Distances

Matrix Grain Size, Reinforcement
Particle size, Indentation Diameter

2. How to install the Imaged version 1.41
(2009)?

http://rsb.info.nih.gov/ij/

M | news | docs | downioad | plugins | macros/dey | hst | inks

Image Processing and Analysis in Java

° LICVEIOPEr IRESOUITes
o Search
@ Related Sites

home | news | docs | download | plugins | macrosfdev | search | links

Download

JAR File (Upgrade or Unix)

To upgrade to v1. 38 or install Image] on a Java-enabled machine, download 133 zip
(2ME) and extract the Tmage] directory. Includes Mac and Windows launchers. The
TUpgrade page has pre-release versions

Mac 0S X
Dovwnload Image] 1.38 (1.7MB) as a double-clickable Mac OS X application. (Instructions)

Linux x86
Download mage] 138 (35MB) for Limuz 286, Inchides the Sun Java 1.5.0_09 runtime and.
the Tmage] source code. (Instructions)

Windows
Download Image] 1.38 bundled with Java 1.6.0_02 (21MB) or without Java (1.7MB).
(Instructions)

Mac 0s 9
Download ImageT 1.36 (2. 1M) as a dovble-clickable Mac OS 9 application. (Instructions)

Documentation
Download the Tmage] documentation (25MB), in HTML format, as a compressed zip
archive, The JavaDoc APT documentation (S67K) is also avalable

Source Code
The Tmage] Tava source consists of 77,000 lines of code in 242 files. Iis available as a zip
archive and as colorized and browsable HTML.

Example Images
31 downloadable sample images and stacks are available in Imagel's File>Cpon Samples
submeny. These images, and more, are also avalable as a 8 2MB zip archive.

The ImageJ icon and its window

Imagel

__i. maged] !3 —Té‘
File Edit Image Process Analyze Plugins Window Help '
Ojolc@ < &/+|5 Al 2| ©sfsual £ |4 &] >

Freehand selections

3. How to calculate the volume fraction ?7?

You may calculate volume fraction from area fraction to any kind of reinforcement,
porous or phases

Create the shortcut  THRESHOLD COLOUR:
Images = B>
Fie Eoit image Frocess Anayze [ wnaow Help

I8 oz || =] ]+ |5 Al R]  vaos AT ES

Calor picksr (93,188,356 Shartcuts »| create shortcut..

Utilties > Inatall Plugin.
New Remave
Edit

Compile ani Run

Analyes
color
Examples
Filters
Graphics
Input-Cuput
Macres
Stacks

Touls

Select the Command and assign the function for Shortcut

.\ Crea

SHOTLETT

command: [Threshold Colour K|

Ghortout

oK Cancel
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Open the picture or micrograph for analyze:

Use preferably images taken to 100X or 200X

CTRL+O

Open the “Threshold Colour” window= F2

e il e

s sop
Select the region (color) to analyze on picture
using tools:

all v
AT s -

Sursion

il age Frocess Analyze Plgins Window Help
ﬁéﬁf\am\mmm.ﬂ\m_\m_\m.ww B
W TIFCTAG) fool

@ Page O amp

™ Theashole I~ nvart
ol | il | etack| el
Sample | # HBE ©ASE O CELab © YUY 8

i ]
Fle Edl inage Prucess A

eha2 PLOM Window help
Slolafl< A\ AR D] * @il 2 s8] =]

e Frerie

- -

i i
L g}

st

e

Biginess.
o Coop

Tz

] ] ] ]

Sate] % 188 RER ~CEL

Press “Sample” button on “Threshold colour” window:

il s

it © sop

‘You can improve the colour selection using
“Hue”, “Saturation” and ‘Brightness” bars

™ Thrashold [ invert

Bamplo | @ HEE ©RBE DL C V4

10

Mark “Threshold” box

The image colour must change to black and white

@ Pas C o

e

v
wi ™ ineen.

B RED CCELE © A &

Samete

11

Turn the image to an “8-bit” image (you may create a shortcut)

The microscope produces a "RGB color” image format, it is necessary fo tum it to a
grayscale photograph

i, =
File Edit Process Anahze Pluging \Window Help
Oloje 48] |»]
“Elliptical™ o Adjust N 16-bit

shaw 1o crw | 220
Propeties.  CkShigsp | O RTEOE
o | v RZE Color
Slacks *| R Slack
crop Cirighittse | HE5 Stack
Duplicate CHrlbSHifaD

Rename

scale... CIri+E

Rotate v

Zoom v

Lockup Tablss .

12
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Calculate the volume fraction on “Analyze Particles” (you may create a shortcut)

(for our intention, the volume fraction is approximated to area fraction)

r}. (ReeAl

- [5[%]

File Fcit Image Process

O/l =) 4|45 vessure

Magnifting olzss {or use +* and " [

Summarizz
Distribution
Lapel

Clear Results

Plugins Window Help

Sl = AP At

Set Measurements.

Set Scale .
Calibrate.
Histogram
Flat Profie
Surface Plot.
(e =]

Toals

d y=2lantiol be)
Size (piel" 2y | O-Infinity
Circularit: | 0.00-1.00

Show: [ Rothing _x

I™ DisplayResuts [~ Excludeon Edgas
[¥ Clear Resulls I Include Hules

W SUMmErE ™ Record Stants

I Add 1o Manager

ok | caneel |

13

T CIEX
Fil= Edit Font
Slice. Count |TozlArea |Average Size Area Fraction ¢

DI-I00GEIPG A7 302167000 3473.018 246

&

You can analyze many pictures

Finally, copy all data {“Select All" and “Copy") and paste it on Excel software

L Summary, [ ID/x]
File Font
Siicel cut i Area Fraction
Copy  GmeD !
Clear

. - 14
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Setting a threshold [42]

Automatic particle analysis requires the image to be a “binary” image i.e. black or
white. The software needs to know exactly where the edges are to perform
morphology measurements. A “threshold” range is set and pixels in the image
whose value lies in this range are converted to black; pixels with values outside this

range are converted to white (or viceversa depending on what the user requests).

[ s e - ppemm— .ax 1 NEre are several ways to set thresholds. For

v i, § LA B2

|

n
Ak i o o wm
i TR

k| Appig]| meae| Ba|

| monochrome images it is most simply done via
thee menu command “Image/Adjust/Threshold”.

£l While the threshold is being set, the pixels within
the threshold range are displayed in red. The user

then changes then “Apply’ the threshold and the

image will be converted to a binary image.

For colour images, setting the threshold is a |

bit more complicated as each of the red,

green and blue channels require different |f

threshold ranges. The plugin “Plugins/Colour

functions/Threshold Colour” can be used to |§

do this most easily. This opens a fairly

complicated and extensive control window. |§
The simplest way to perform a colour |;

P[e | - theoshad Cocr

o e

threshold is to use one of the selection tools ||

to select one of the objects of interest, and
then click the “Sample” button in the
“Threshold Colour’ control window. This
should remove the pixels in the image that
do not have pixels of the same colour as
those in the selection. The thresholding can
be manually tweaked with scroll bars in the
histogram panes. It may be easier to
conceptualise what you are doing at this
point by switching the Control window from
the default Hue, Saturation and Brightness
colour model to red, green blue model by
switching the option buttons at the bottom of
the control window. The image can be
displayed as a binary image with the
“Threshold” button, and converted to a
binary image via the menu command
“Image/Type/8-bit’ .

F Trshad T Insad
[ongrad | i sk [ |

;'a":'-—'nc'-z'j B AN 1 CE L
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Type Submenu [43]
Use this submenu to determine the type of the active image or to convert it to
another type.

8-bit
Converts to 8-bit grayscale. The active image must be 16-bit grayscale, 32-bit
grayscale, 8-bit color or RGB color.

Imaged converts 16-bit and 32-bit images and stacks to 8-bits by linearly scaling
from min-max to 0-255, where min and max are the two values displayed in the
Image>Adjust>Brightness>Contrast tool. Image>Show Info displays these two
values as the "Display range". Note that this scaling is not done if "Scale When
Converting" is not checked in Edit>Options>Conversions.

RGB images are converted to grayscale using the formula gray=(red+green+blue)/3
or gray=0.299red+0.587green+0.114blue if "Weighted RGB to Grayscale
Conversion" is checked in Edit>Options>Conversions.

Analyze Particles [43]

This command counts and measures objects in binary or thresholded images. It
works by scanning the image or selection until it finds the edge of an object. It then
outlines the object using the wand tool, measures it using the Measure command,
fills it to make it invisible, then resumes scanning until it reaches the end of the
image or selection. Press the esc key to abort this process. Use
Image>Adjust>Threshold to threshold an image.

i SUMMar
TR P P — aUummanry
HoDs. ol | + lesuits &

136x102 pixels, 8-bit, - T TAwa [Wean i
1]6:1[)2 pixels; 8-bit; FET: 195.953 0868 =< Threshold: 126- 248

'
C L7
.' @ 156  183.346 0810 T”t”_”m A AL
' Cp 426 201.840 0690 1 o A

T Average Size: 471.143 pixela?
676 108994 772 40 gRSEE S s
Area Fraction: 23, 8%

361 197.208 0906 32
B10x 189.718 0D.BOS 4
641 192.624 0702 3

Use the dialog box to configure the particle analyzer. Particles outside the range
specified in the Size field are ignored. Enter a single value in Size and particles
smaller than that value are ignored. Particles with circularity values outside the
range specified in the Circularity field are also ignored. The formula for circularity is
4pi(area/perimeter’2). A value of 1.0 indicates a perfect circle.
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enn Analyze Particles

Size (pixelA2): O-Infinity

Circularity: 0.00-1.00

Show: = Masks F:j
o Display Results _ Exclude on Edges
# Clear Results # Include Holes
[l Summarize [ Record Starts

_ Add to Manager

(L Cancel )L OK 4

Select Outlines from the "Show:" popup menu and Imaged will open a window
containing numbered outlines of the measured particles. Select Masks to display
filled outlines of the measured particles or Ellipses to display the best fit ellipse of

each measured particles.
@ ‘e "0
X | jod| ol
Oo ®e D
. Ol @ " O

"Outlines” "Masks” "Ellipses”

Qriginal image Thresholded using

Image=Adjust=Threshold

Check Display results to have the measurements for each particle displayed in the
"Results" window. Check Clear Results to erase any previous measurement results.
Check Summarize to display, in a separate window, the particle count, total particle
area, average particle size, and area fraction. Check Exclude on Edges to ignore
particles touching the edge of the image or selection.

Check Include Holes to include interior holes. Disable this option to exclude interior
holes and to measure particles enclosed by other particles. When this option is
enabled, Imaged finds the extent of each particle by tracing the outer edge. When it
is disabled, ImagedJ finds the extent by flood filling.
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. @

original image default settings "Include Holes" disabled "Exclude on Edges”
(thresholded) (Show="masks")

'o..b o. S

° .) 1 %@ !
Size=300-99999 pixel*2  Size=1-300 pixel*2 Circularity=0.8-1.0 Size=200-99999
Circularity=0-.6

The Record Starts option allows plugins and macros to recreate particle outlines

using the doWand(x,y) function. The CircularParticles macro demonstrates how to
use this feature.

Check Add to Manager and the measured particles will be added to the ROI
Manager.
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